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Getting started

This guide assumes that you have a background in telecommunications local
service, including some knowledge of CenturyLink products and order-writing
conventions. This guide is for system administrators who

e manage your company'’s account
e manage IMA users and other system administrators in your company

Although the IMA System Administration window lists an option for billing
account numbers, CenturyLink now manages this information for you.

Logging in to IMA

To log in to IMA, open a browser window and follow the guidelines in chapter 5
of the Connection Guide.

Interconnect Login

Interconnect
Medlated

Enter your Corporate ID, Username and Password then Click 'Login'.

Corporate ID:
TUsername:
Password:

Clear

% Locd] irtranet 1o v

1 Fill in the three fields, using the values given to you by your CenturyLink
system administrator.

e Note that the fields are case-sensitive.

e Once you have logged in for the first time, be sure to change your
password.

2 Click Login.

October 20, 2014 5
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Creating your personal profile

1—Getting started
Creating your personal profile

The first time you log in to IMA, you must complete a personal profile before
you can go on to other tasks. Your personal profile contains information that

CenturyLink uses to contact you.

{2 Personal Profile - Windows Internet Explorer,

Go- &

fle Edt View Favortes Took  Hel

P g e

age ~ 3 Tooks - (@) Help -

] [#2][x -

Either an Email address or valid Fax Number is required as part of the User Profile information.

Personal Profile

Name:
Telephone Number:
E-Mail Address:
Fax:
Street Address:
Floor:
Room/Mail Stop:
City:

State: | AL~
Zip/Postal Code:

[ Updste Database | [ Logout |

& Local intranet.

H100% -

1 Click in each field and type the appropriate information. All fields are

required except for

e E-mail Address or Fax (You must fill in at least one of these.)

e Floor
e Room/Mail Stop

Note: In the Telephone Number and Fax fields, use the format 000-

000-0000.
2 Click Update Database.

IMA displays a message that the database has been updated.

3 Click Return to Main Menu.

Note: Clicking Logout clears all data and returns you to the
Interconnect Login window. You will still need to create your

personal profile at next log in.

You can change your personal profile at any time to keep it current. See

“Modifying your personal profile” on page 38.

Logging out of IMA

October 20, 2014

To log out of IMA, click Return to Main Menu, then click Logout.
If you're working in PreOrder/Order/PostOrder, you may first have to click
Cancel, Close, or Finish to close the window(s). Then, click File > Exit to

close the Interconnect Mediated Access window.

http://www.centurylink.com/wholesale/ima/gui/index.html
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IMA hours (Mountain Time)

IMA hours (Mountain Time)

Monday-Friday 6 a.m. to midnight
Saturday 6 a.m.to9 p.m.
Sunday 10 a.m. to 7 p.m.

Additional resources

Web sites

IMA GUI Error Messages

http://www.centurylink.com/wholesale/ima/gui/all_errormessages_a-
c.html

Local Service Ordering Guidelines
http://www.centurylink.com/wholesale/clecs/Isog.html

Products and Services
http://www.centurylink.com/wholesale/pcat/index.html

CenturylLink E-Business
http://ecom.centurylink.com

Wholesale Customer Contacts business procedure
http://www.centurylink.com/wholesale/clecs/escalations.html

Wholesale Resources—IMA
http://www.centurylink.com/wholesale/ima/index.html

Documents

In addition to this document, CenturyLink provides four other guides to help
you use IMA. The first three guides are available at
http://www.centurylink.com/wholesale/ima/gqui/index.htmil:

e IMA Connection Guide—guidelines for connecting to IMA

e [MA User’s Guide—guidelines on preparing, submitting, and following up on
LSRs

e Facility-Based Directory Listings Guide—guidelines for submitting orders
for facility-based directory listings

The fourth guide is available at
http://www.centurylink.com/wholesale/training/coursecatalog.html:

e Loop Qualification and Raw Loop Data CLEC Job Aid—guidelines for
retrieving raw loop data and for checking whether a loop qualifies (for
CenturyLink HSI/Broadband Service or for unbundled ADSL service)

October 20, 2014 7
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Managing your company’s account

You manage your company’s account by

e creating or modifying your company’s autofill information (directly below)
e viewing and changing your company’s user profile (page 10)

e managing your company’s BANS—billing account numbers (page 13)

e viewing and changing your LSR purge interval (page 15)

e managing your Pending Service Order Notice (PSON) settings (page 17)
e managing your completion notice settings (page 17)

Although viewing reference data is listed on the Interconnect Functions
window, that task is normally done by the users in your company. For
guidelines on viewing the reference data, see the IMA User’s Guide.

Managing your company'’s autofill information

Corporate autofill information fills in contact information for your company. It
is not customized for individual users.

October 20, 2014 8
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Managing your company'’s autofill information

CLEC System Administrator’s Guide—IMA 37.0

1 In the Interconnect Functions window, click System Administration.

£ IMA System Administration - Windows Internet Explorer

LEX

|52 X

2

G-k

Ble Edt Yew Favortes Inols Help

¢ ar  {fGHome - @@Pdnt v ihPage - £ Took - (@) Help -

IMA System Administration

« Account Administration

o Add/Modify Corporate Autofill
Information

o Add/Remove Agent

o Receive notifications for expired Agent
requests

o View Corporate User Profile

o Add/Modify Billing Account Number

o Set Co-Provider System Parameters

o View Pending Service Order Notice

« User Administration

Add User

Add/Modify User Autofill Information
Set User Name

Set User Password

o Set User Access

o Set User State

« Reports
Get BAN List
Get User List

o Get Agent/Owner List

« Return to Main Menu

& Local intranet F100% v

Under Account Administration, click Add/Modify Corporate Autofill

Information.

{2 #ddfModify Corporate Autofill Information - Windows Internet Explorer.

i fle Edk View Favorkes Took Help

e o fRtome - dehPrre

v #2 ][ x 2l

- [ page ~ €3 Tools - @ Hel -

Add/Modify Corporate Autofill Information

Enter Corporate Autofill Information Below:

CORPORATE ID: u99

DSGCON TEL NO:
CC: DSGCON FAXNO:
IMPCON: DSGCON STREET:
IMPCON TEL NO: DSGCON FLOOR:
ALT IMPCON: ?’?(?EON ROOM/MAIL
iLOT IMPCON TEL DSGCON CITY:
DSGCON: DSGCON STATE: 1
DRC: DSGCON ZIP:
DSGCON E-MAITL:
AUTOFILL: NO ¥

Return to System Administration

Done

& Local intranet

H100% -

3 You must fill in either the DRC or the DSGCON FAX NO field, but not both.
Have IMA automatically fill in the other information by typing the contact
information in any or all of the fields:

In this field ...

Type ...

CC

Your CIC (carrier identification code )

October 20, 2014
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2—Managing your company’s account
Managing your company’s user profile

In this field ...

Type ...

IMPCON

Implementation contact

IMPCON TEL NO

Phone number for implementation contact

ALT IMPCON

Alternate implementation contact

ALT IMPCON TEL NO

Phone number for alternate implementation contact

DSGCON

Design engineering contact

DRC

Design routing code

DSGCON E-MAIL

E-mail address for design engineering contact

DSGCON TEL NO

Phone number for design engineering contact

DSGCON FAX NO

Fax number for design engineering contact

DSGCON STREET

Street address for design engineering contact

DSGCON FLOOR

Floor or suite number for design engineering contact

DSGCON ROOM/MAIL STOP Room or mail stop for design engineering contact

DSGCON CITY City for design engineering contact

DSGCON STATE State for design engineering contact

DSGCON ZIP ZIP Code for design engineering contact

4 If you want IMA to automatically fill in this information when your users
prepare the LSR form, select YES in the AUTOFILL field.

5 Click Add/Modify Autofill.
6 Click Return to System Administration.

Managing your company’s user profile

You can view your company’s corporate user profile. The corporate user profile
lists, by state, what services your company is allowed to offer. It also verifies
how your company wants to receive various types of notices. This is a view-
only window.

1 In the Interconnect Functions window, click System Administration.

October 20, 2014 10
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Managing your company'’s user profile

CLEC System Administrator’s Guide—IMA 37.0

2 Under Account Administration, click View Corporate User Profile.

= Corporate User, Profile - Windows Internet Explorer

Co- & == =
i Fle Edit View Favortes Tools Help
r 4 firome - AhPune v | Page - 0 Todls - @) Help -

Corporate User Profile

Corporate User ID: U99

Corporate User Name: ‘[‘(’our company name] |

Certifted to do Business

‘ State |Business |Resideru:e mmon-lmpaired 5CA

‘Ariznna | W~ | 1z F| r ,l_i
‘Coloradu | ~ | 12 ’l__| r ,l_—
[Idaho (= (= ERE =N
TS [ =
‘I\,Iinnesnta | = | 1z F| r ,l_i
‘Montana | ~ | 12 ’l__| r ,l_—
‘Nebraska | I3 | ~ ’l__| ~ ,l_—
‘NEW Texico | I | w F| r ,l_i
[North Dakota |7 = == =0
‘Oregon | ~ | 17 ’l__| r ,l_—
South Dakora [# " ERIE =N
Utah [ [ ERE =N
‘Washingmn | I | 1= F| ~ ,l_i
Wyoming [P [ ERE =N

[IWireless

Select Electronic Line Loss Notifications
[ Send Line Loss to Trading Partner ID-

Select GUI Line Loss Notifications
[[JSend Line Loss to E-Mail

and/or Fax:
Line Loss Notification Inactive

[ ]
[ ]

2008-02-14 13:31:16.0

Select Electronic Status Update Options
[FILSR Statuses [¥] Order Statuses [#]Enable BHC Statuses

Receive Non-Fatal Errors

CLEC TAP/Lifeline Guideline Compliance

[ Certified

by CLEC authorized officer: | |
on date: 1

ticket #: [ |
Updated: Thu Nov 20 11:00:46 MST 2008

[ Prohibit LSR Reject Override

Return to System Administration

Done

4 Local intranet #100% T

11
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2—Managing your company’s account
Managing your company’s user profile

3 Review the information in the window.

Field

Description

Certified to do Business

A list of states in which you are certified to do business
and the type of business you are authorized to
perform.

Wireless

If checked, you have authorization for wireless
business.

Select Electronic Line Loss
Notifications

If checked, you want to send Line Loss information to a
trading partner.

Select GUI Line Loss
Notifications

If checked, you want to be notified of line loss via e-
mail or fax.

Select Electronic Status
Update Options

If checked, you want updates on LSR status, order
status, Batch Hot Cut status, or all three.

Receive Non-Fatal Errors

If checked, you want to receive non-fatal errors.

CLEC TAP/Lifeline Guideline
Compliance

If checked, indicates the CLEC has TAP/Lifeline
certification allowing for low income assistance
program for subsidized phone service.

Prohibit LSR Reject Override

If checked, the LSR Reject Override is not available.

http://www.centurylink.com/wholesale/ima/gui/index.html

4 When you are done, click Return to System Administration.

To change the corporate user profile, contact the CenturyLink Wholesale
Systems Help Desk at 888-796-9102 and select option 2.

12
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Managing your company’s BANs

Managing your company’s BANs

As a system administrator, you manage the BANs—billing account
numbers—for your company. By managing BANs, you control the list of BANs
that appear in the BAN list in the Order Information for New LSR/BRC
window. Using IMA, you can add, modify, delete, and view more information
your company’s BANs. You can also view a list of all the BANs your company
has in IMA. (See page 15.)

Adding a BAN

1 In the Interconnect Functions window, click System Administration.
2 Under Account Administration, click Add/Modify Billing Account

Number.
{= Billing Account Number - Windows Internet Explorer g@@
Go- & oo aF

© Bl Edt Vew Favorkes Took Help

¢t Mitome - MPdnt v [ Page v i Tooks v @ Help -

Billing Account Number
Enter Billing Account Number for Corporate ID: U99.
Billing Account Number:

Return to System Administration

& Local inkranet #100% -

3 Type the BAN you want to add, then click Get BAN Info.

{2 Billing Account Number - Windows Internet Explorer

L< IS0 %[ Pl
Fle Edit Yiew Favorites Tools  Help

dr o fGHome - @Pone - [ Page - 0 Tools + @) Help -

Billing Account Number
Corporate User ID: U99

Billing Account Number: TESTBAN123456 [] Delete BAN
Description:
Billing Name:
Street Address:
Floor:
Room/Mail Stop:
City:
State: AL v

ZIP/Postal Code:

Tax Exemption: F&SECEM v
Billing Account Print Cycle:

Update Database

Return to BAN Entry Screen

& Local intranet H100% v

4 Fill in the information for the new BAN, then click Update Database.

IMA saves the information for the new BAN. This BAN now appears in the
BAN list in the Order Information for New LSR/BRC window and can
be used when submitting LSRs.

13
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Managing your company’s BANs

5 When you are done, click Return to BAN Entry Screen, then click
Return to System Administration.

Modifying a BAN

1 In the Interconnect Functions window, click System Administration.

2 Under Account Administration, click Add/Modify Billing Account

Number.
{Z Billing Account Number - Windows Internet Explorer B
G- = ][4 [x e
Fle Edk View Favortes Tooks Help
¢ ot fpteme - dhPure - [ page + i Taols + @ Hel -
Billing Account Number

Enter Billing Account Number for Corporate ID: U99.
Billing Account Number:

Return to System Administration

% Local intranet E100% v

3 Type the BAN you want to edit and click Get BAN Info.
IMA displays the detailed information for the BAN you specified.

Make the necessary changes to the BAN information and click Update
Database.

IMA updates the BAN with the new information.

5 When you are done, click Return to BAN Entry Screen, then click
Return to System Administration.

4

Deleting a BAN

1 In the Interconnect Functions window, click System Administration.

2 Under Account Administration, click Add/Modify Billing Account

Number.
{Z Billing Account Number - Windows Internet Explorer B
G- = 4] [x ol
Fle Edk View Favortes Tooks Help
ik e fjrome - dmipant < |- page v ) Taok + @ Hep -
Billing Account Number

Enter Billing Account Number for Corporate ID: U99.
Billing Account Number:

Return to System Administration

S Local intranet FA00% v
3 Type the BAN you want to delete, then click Get BAN Info.

IMA displays the detailed information for the BAN you specified.
4 \Verify that the BAN you type is the BAN you want to delete.

October 20, 2014 14
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Managing your LSR purge interval

5 Click Delete BAN, then click Update Database.

IMA deletes the BAN. This BAN no longer appears in the BAN list in the

Order Information for New LSR/BRC window and can no longer be
used for submitting LSRs.

6 When you are done, click Return to BAN Entry Screen, then click
Return to System Administration.

Viewing more information for a BAN

1 In the Interconnect Functions window, click System Administration.

2 Under Account Administration, click Add/Modify Billing Account
Number.

e Billing Account Mumber - Windows Internet Explorer

G- e v |4 x 2~
Fle Edt Vew Favortes Toos Help

7% & fGtome v dpint < [5bPage + ) Tools - @ He -

Billing Account Number
Enter Billing Account Number for Corporate ID: U99.
Billing Account Number:

Return to System Administration

% Local inkranet. H100% v

3 Type the BAN you want to view more information for, then click Get BAN
Info.

IMA displays the detailed information for the BAN you specified.

4 When you are done, click Return to BAN Entry Screen, then click
Return to System Administration.

Viewing a list of all BANs for your company

1 In the Interconnect Functions window, click System Administration.
2 Under Reports, click Get BAN List.
IMA lists all BANs for your company.

3 When you are done, click Return to System Administration.

Managing your LSR purge interval

You can change the frequency with which IMA purges your LSR queue. This
queue contains LSRs that were submitted after IMA business hours and could
not be processed when IMA reopened for business because of errors.

1 In the Interconnect Functions window, click System Administration.

15

October 20, 2014
http://www.centurylink.com/wholesale/ima/gui/index.html



CLEC System Administrator’s Guide—IMA 37.0 2—Managing your company’s account

Managing your LSR purge interval

2 Under Account Administration, click Set Co-Provider System
Parameters.

(= Set Co-Provider System Parameters - Windows Internet Explorer,

G-k 0E
fle Edt View Favortes Tooks  Help

i o MiHome - @BPint v [ Page = £ Took - @) Help -

Set Co-Provider System Parameters

Select Purge Interval for Corporate ID: U99.
Quened LSRs Purge Interval: | BFWEEKLY v

Set Parameters

Return to System Administration

S Local intranet. o0k -

The Corporate ID field is always automatically filled in with your
CenturyLink-assigned corporate ID.

3 From the list, select the purge interval you want.
4 Click Set Parameters.

IMA displays a message that the LSR purge interval was changed.
5 C(Click Return to System Administration.

October 20, 2014 16
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Managing PSON settings

Managing PSON settings

You can view the PSON settings for your corporate ID. This is a view-only
window.

1
2

In the Interconnect Functions window, click System Administration.

Under Account Administration, click View Pending Service Order
Notice.

{= Pending Service Order, Notice System Parameter - Windows Internet Explorer g@@
@v [ ¥ 4 X S

Tooks  Help

% df  MyHome - dmhPrint v |2} Page + i Took - @ Hep -

Pending Service Order Notice System Parameter

Receive Pending Service Order Notices for Corporate ID: U99.

Receive Pending Service Order Notices: N
Receive Pending Service Order Notices Effective Date: 2008-08-07 18:33:10.0

Return to System Administration

&J Local intranet H100% -

3 Review the information in the window. When you are done, click Return to
System Administration.

To change the PSON settings on this screen, contact the CenturyLink
Wholesale Systems Help Desk at 888-796-9102 and select option 2.

Managing completion notice settings

17

You can elect not to receive completion notices for your LSRs. To stop (or
restart) receiving completion notices, call the Wholesale Systems Help Desk at

888-796-9102 and select option 2. (Changing your completion notice settings
does not affect DSRED notices.)

October 20, 2014
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Managing users

As a system administrator, you manage user access within your company,
including:

e adding a user (directly below)

e changing a user’s access level (page 20)

e changing a user’s system access (page 20)
e changing a username (page 21)

e changing a user’s password (page 22)

e viewing a list of users (page 24)

e creating or managing user autofill information (page 25)

Adding a user

You can add a new user in either of two ways:

e by following the procedure below
This is the most direct way to create a new user.

e by reactivating an inactive user account (see page 20) and assigning a new
username (see page 21)
This procedure is less direct, but it is a good way to reuse inactive accounts
and maintain a more efficient database.

If a single user needs two different access levels (see page 20), you must add
the user twice—that is, with two different usernames. You then assign the
appropriate level of access to each username.

1 In the Interconnect Functions window, click System Administration.

October 20, 2014 18
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Deleting a user

2 Under User Administration, click Add User.

(= Add User - Windows Internet Explorer Q@@
@ - &l | [ #2)| X £~
File  Edt Wiew Favorites Tools  Help
T MyHome - dmhPrint v <) Page v i Took - @ Hep -

Add User

Enter User Information for Corporate ID: U99.

Username:
Password:

Re-Type Password:

Return to System Administration

% Local intranet H100% -

Note: The Corporate ID field is always automatically filled in with
your CenturyLink-assigned corporate ID.

3 Fill in the fields:

In this field ... Type ...

Username The username for the new user (3-8 characters). The
username must be unique within your corporate ID

Password The password for the new user (6-8 characters, at least
one of which is a number or special character)

Re-Type Password

4 Click Add User.

IMA displays a message that the user was added. IMA automatically sets
the new user access level to user and their status to active.

5 Click Return to System Administration.

6 If the user you added performs both user and admin tasks, repeat this
procedure to add a second username for the user.

7 If the access level for the new user needs to be different than the IMA
default of user, see “"Changing a user’s access level” on page 20

Deleting a user

You cannot delete users from IMA directly. But if users no longer require
access to the system, you can inactivate their usernames, reactivate those
usernames, and reassign them to new users (see “"Changing a user’s access
level” on page 20 and “Changing a username” on page 21).
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Changing a user’s access level

There are three types of user access levels.

Access Level Description

user Users who need access to IMA PreOrder, Order and

PostOrder functions—the default access level when you
create a new user

admin Other administrators

pre_order_user Users who need access to IMA PreOrder functions only

You can change a user’s user access level to admin or pre_order_user. You

can also change an existing admin or pre_order_user access level back to
user.

1 In the Interconnect Functions window, click System Administration.

2 Under User Administration, click Set User Access.

_f Set User Access - Windows Internet Explorer @@E}
G- = o] 4] [ 2l

Ele Edt Wiew Favorites Took Help

i o Fytome - dmheunt - [ page - {0 Tools - @ Hep -

Set User Access

Enter User Name and Select Access Level

Username:

Access Level: |user -

SetAccess Level

Return to System Administration

Done

& Local intranet #100% -

3 Fill in the fields:

In this field ... Do the following ...
Username Enter the username whose access level you want to change
Access Level Select the new access level from the list

4 Click Set Access Level.

IMA displays a message stating that the user’s access level was changed.
5 Click Return to System Administration.

Managing users’ system access

Whether users can log in to IMA is determined by their state, active or

inactive. You can manage users’ access to IMA by assigning them the correct
state.

October 20, 2014 20
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Changing a username

When you create a new user, IMA automatically makes the user’s state
active so that they can log in.

When a user no longer requires access to IMA, you can change their state
to inactive.

If an inactive user requires access to IMA, you can set their user state back
to active.

You can reassign an inactive user’s account by changing it to active and
then changing the user name. See “Generating a list of users” on page 24.

To assign a new user to IMA or to change the state of an existing user, use this

procedure:
1 In the Interconnect Functions window, click System Administration.
2 Under User Administration, click Set User State.
(= Set User State - Windows Internet Explorer g@
@ M [} ¥ 4 X Paihd
File Edit Wwiew Faworites Tools  Help
% & fGtome - dePrint < [} Page v {3 Tooks + @ Hep -
Set User State
Enter User Name and Select State
Username:
State: | ActiveUser v
Return to System Administration
S Local intranst HA0% -
3 In the Username field, type the username whose access you want to
change.
4 Do one of the following:
e To deactivate the user, select InActiveUser from the list.
e To reactivate the user, select ActiveUser from the list.
5 Click Set State.

IMA displays a message that the user has been set to Active or InActive.
Click Return to System Administration.

Changing a username

You can change a username to get a better match between the username and

the user’s actual name.

You can assign a new username only to an active user ID, not an inactive user
ID (see “Managing users’ system access” on page 20). If the username is
inactive, be sure to activate it first.

1 In the Interconnect Functions window, click System Administration.

October 20, 2014
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2 Under User Administration, click Set User Name.

Set User Name

Enter Old User Name and New User Name

Old Username:

New Username:

Return to System Administration

Done % Local intranet #100% -

3 Fill in the fields:

In this field ... Type ...
Old Username The username you want to change
New Username The new username you want to use

4 Click Set Name.

IMA displays a message that the username was changed.
5 Click Return to System Administration.

Changing a user’s password

If a user cannot log in because of a forgotten password, you can assign a new
password. The CenturyLink Wholesale Systems Help Desk (888-796-9102) can
also change a user’s password.

1 In the Interconnect Functions window, click System Administration.
2 Under User Administration, click Set User Password.

/2 Set User Password - Windows Infernet Explorer A=
oo« s -

fle Edt View Favortes Took  Help

S ar  MiHome - @BPint - [ Page = £ Took - @) Help -

Set User Password

Enter User Name and New Password.

Username:
New Password:
Re-Type New Password:

Return to System Administration

Done

& Localintranet F 0%

October 20, 2014 22
http://www.centurylink.com/wholesale/ima/gui/index.html



CLEC System Administrator’s Guide—IMA 37.0

3 Fill in the fields:

3—Managing users
Changing a user’s password

In this field ...

Type ...

Username

The username for the user

New Password

Re-Type New Password

The user’s new password (6-8 characters, at least one of which
is @ number or special character)

Tip: IMA passwords don’t expire, but for security reasons, you should
change your password often.

4 Click Set Password.

IMA displays a message that the user’s password was changed.

5 C(Click Return to System Administration.

October 20, 2014
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3—Managing users
Generating a list of users

You can generate a list of all users for your corporate ID. The list shows each
user’s username, name (the name they used in their personal profile), state
(active or inactive), access level, and the date (and how many days since) the

user last logged in.

1 In the Interconnect Functions window, click System Administration.

2 Under Reports, click Get User List.

Corporate ID: U99

UserStatus: | Active

Sort By: [Userame v

Done

(2 Get User List - Windows Internet Explorer =S
- = ] [#2][x P
Fle Edt View Favortes Took Help
% e Mitome - dhPint v [ Page v 0 Tooks ~ @ Hep -
.
Get User List

Return to System Administration

3 From the UserStatus list, select whether you want to view active users,

inactive users, or both.

4 From the Sort By list, select how you want the list to be sorted. (If you
select Login Date, IMA sorts first by date—oldest to newest—and then by

username.)
5 Click Get User List.

IMA displays a list of users for your Corporate ID. (If an entry in the user
list does not contain the user’s name, the user has not completed their

personal profile.)

6 When you are done with the list, click Return to System Administration.

October 20, 2014
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Creating or managing user autofill
information

User autofill information customizes contact information for individual users.
1 In the Interconnect Functions window, click System Administration.

2 Under User Administration, click Get User Autofill Information.

{Z Get User Autofill Information - Windows Internet Explorer (=]

Oo- & TOE o

Fie Edt Yew Favortes Tooks Hep

% e Mitome - dhPint v [ Page v 0 Tooks ~ @ Hep -

Get User Autofill Information

Corporate ID: U99

Username:

| Getuser Autofill Information |

Return to System Administration

% Local intranst #100%

3 Type the username of the user for whom you want to create autofill
information.

4 Click Add/Modify User Autofill Information.

{2 AddfModify User, Autofill Information - Windows Internet Explorer
—
@ wy - 2] IENIES o~

Fie Edt Yew Favortes Tooks Hep

%% g Fprome - dPdnt v [0 page v {0 Took ~ @) Help -
2, 3

Add/Modify User Autofill Information

Enter User Autofill Information Below:

CORPORATE ID: 99

USERNAME: clec_usr DSGCON TEL NO:

CC: DSGCON FAX NO:

IMPCON: DSGCON STREET:

IMPCON TEL NO: DSGCON FLOOR:

ALT IMPCON: DSGCON ROOM/MAIL STOP:

ALT IMPCON TEL NO: DSGCON CITY:

DSGCON: DSGCON STATE: v
DRC: DSGCON ZIP:

DSGCON E-MAIL:

Add/Modify Autofill

Return to System Administration

Done % Local intranet H00% v
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Creating or managing user autofill information

5 You must fill in either the DRC or the DSGCON FAX NO field, but not both.
Have IMA automatically fill in the other information by typing the contact

October 20, 2014

http://www.centurylink.com/wholesale/ima/gui/index.html

information in any or all of the fields:

In this field ...

Type ...

ccC

Your CIC (carrier identification code)

IMPCON

Implementation contact

IMPCON TEL NO

Phone number for implementation contact

ALT IMPCON

Alternate implementation contact

ALT IMPCON TEL NO

Phone number for alternate implementation contact

DSGCON

Design engineering contact

DRC

Design routing code

DSGCON E-MAIL

E-mail address for design engineering contact

DSGCON TEL NO

Phone number for design engineering contact

DSGCON FAX NO

Fax number for design engineering contact

DSGCON STREET

Street address for design engineering contact

DSGCON FLOOR

Floor or suite number for design engineering contact

DSGCON ROOM/MAIL STOP

Room or mail stop for design engineering contact

DSGCON CITY

City for design engineering contact

DSGCON STATE

State for design engineering contact

DSGCON ZIP

ZIP Code for design engineering contact

6 Click Add/Modify Autofill.

7 Click Return to System Administration.
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As a system administrator, you can add or remove agents who process LSRs or
trouble reports on your behalf. When you add agents, you authorize them to
use IMA, CEMR-MTG, or MTG. When you remove an agent, you can redirect
the LSR notices originally submitted by that agent.

Adding or removing agent

In the Interconnect Functions window, click System Administration.

Under Account Administration, click Add/Remove Agent.

= hdd/Remove Agent - Windows Internet Explorer

G- la %[ =

Fie Edt Yew Favortes Tooks Hep

o ot fRHome - bt - [ Page ~ {3 Tolks + @) el -

Add/Remove Agent

Corporate ID: U99

Application: v
New Agent ID:

[ GetAgent ” Add Agent ][ Remove Agent ]

Return to System Administration

4 Local intranet

3 To add an agent, continue with the procedure directly below. To remove an
agent, skip to "Removing an agent” on page 28.

Adding a new agent

1

October 20, 2014

In the Application field, select the application for which you want to add

the agent.

In the New Agent ID field, type the corporate ID of the agent you want to

add.
Click Add Agent.

A message at the top of the window indicates that the agent will be added
for the corporate ID and application you specified. This becomes effective

the next business day.
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Redirecting notices for LSRs submitted by expired agents

Note: You cannot add multiple relationships with the same agent. Your
corporate ID and agent ID cannot be the same.

Removing an agent

Important: Before you can remove an agent, you must first redirect
the LSR notices for LSRs submitted by that agent—that is,
you must specify who is to get those notices when the
agent relationship expires. If you do not first redirect the
notices, the agent will not be removed after the required
eight day period.

If you haven't already redirected the notices for the agent you want to
remove, follow the guidelines in “"Redirecting notices for LSRs submitted by
expired agents” on page 28.

1 In the Application field, select the application for which you want to
remove the agent.

2 Click Get Agent.

= hdd/Remove Agent - Windows Internet Explorer @@E
6o - o TR e
Ele Edt Wiew Favorites Took Help
o o fjreme ~ dshpure - [ page ~ {0 Taols - @ Heb -

Add/Remove Agent

Corporate ID: U99

Application: [ IMA -

EN 01-23-2009
Agent IDs:

New Agent ID:

[_GetAgent | [ AddAgent | Remove Agent | [Clear]

Return to System Administration

% Local intranet. H100% v

3 In the Agent IDs list, select (highlight) the agent you want to remove and
click Remove Agent.

The agent relationship expires the next business day.

4 If IMA prompts you to redirect the notices for LSRs submitted by expired
agents, follow the guidelines in the next section.

Redirecting notices for LSRs submitted by
expired agents

If agents submit LSRs on behalf of your company, LSR notices are normally
sent to those agents. Before you can remove an agent, you must specify
where you want LSR notices to be sent so they’'ll be redirected if the agent
relationship expires after the agent has submitted an LSR.

28 October 20, 2014
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Note: You can forward the notices to agents, but only the owner can
work with LSRs submitted by former agents—that is, only the
owner can view or open those LSRs or their status updates,
submit supplements to the LSRs, or work with their jeopardies.

1 In the Interconnect Functions window, click System Administration.

Under Account Administration, click Receive notifications for expired
Agent requests.

& Expired Agent Notification - Windows Internet Explorer

&G - = I 2l

Fie Edt biew Favortes Tooks Hep

% & fGtome - d=pint < [k Page - () Tooks - @) Hep -

Expired Agent Notification

Corporate ID: U99

Select Expired Agents' request nofifications:
Send GUI notifications to E-Mail: [fpasegov[rsthr
and/or Fax:
Send electronic notifications to Trading Partner ID: [IMANUT v
Last updated on: 09/06/2008 02:54:01 AM

Return to System Administration

% Local intranet R

3 For LSR notices, type the e-mail address and/or the fax number to which
you want the notices sent.

4 For electronic notices, select the trading partner ID to whom you want the
notices sent.

Note: Be sure to select a trading partner that uses the same release as
the expired agent; otherwise, the trading partner you select
won’t receive the notices.

5 Click Submit.

Generating a list of agents or owners

You can display a list of the agents currently working on your behalf or a list of
other CLECs you are currently supporting.The list shows the beginning date of
the agreement and—if the agreement has been terminated—the date it will
expire.

1 In the Interconnect Functions window, click System Administration.
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In the IMA System Administration window, under Reports, click Get

Agent/Owner List.

= Get Agent/Owner List - Windows Internet Explorer,

’gjv £l IENIES

Fle Edt Wiew Favortes Took  Hep

T MyHome - @mhPrint v |7} Page + { Took - @) Hep -

2

Get Agent/Owner List

Corporate ID: U9

Application: | IMA v
Relation: Agent v

Get Agent/Owner List

Return to System Administration

% Local intranet

H 0% -

In the Application list, leave IMA selected unless you are a CEMR-MTG or

MTG system administrator.

In the Relation field, select either Agent or Owner.

Click Get Agent/Owner List.

October 20, 2014

http://www.centurylink.com/wholesale/ima/gui/index.html



s :
-~ CenturyLink~

5

Managing clipboard access

You can configure a computer so that a user can copy and paste data between
IMA and other applications, such as e-mail, that have system clipboard access.
To configure a computer, you modify the java.policy file on that computer.
(Even without modifying the java.policy file, your users can still copy and paste
within IMA.)

Enabling system clipboard access

CenturyLink strongly recommends that only an IT system administrator
complete this procedure.

Caution: Enabling system clipboard access may have adverse effects
on the user’s system and could allow malfeasant code to
share potentially sensitive or confidential clipboard
information with external sources. CenturyLink advises
against enabling system clipboard access and disclaims
responsibility for any resulting adverse effects. User
acknowledges that by enabling this access it is doing so at
its own risk.

To modify your java.policy file

1 Close all applications on your system.
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2 Create a backup copy of the “java.policy” file from the folder C:\Program
Files\Java\jrel.7.0_xx\lib\security (where xx is either 00 or 51. If you have
folders for both jrel1.6.0_30 and jrel.7.0_51, use the jrel.7.0_51folder.).

To backup the file, highlight it, select Edit > Copy, then select Edit >

Paste
=10l x|
File Edit \View Favorites Tools Help | .'?‘f:
@ Bk > .@ 2 lj: j_rj Search [C’ Falders ‘ |'$ d?‘ x n | '
Address I[E] Ci\Program Files\Javaljre 1.6,0_30Yib \security j Go
Folders x Q blacklist ti local_policy.jar ;I
503 jel.6.0_30 = [EE3] Fie | | Executable Jar File
- - 444 i s I KB
&3 bin ot o
23 lib
Q cacerts
- applet File I sava.security
) audio B SECURITY File
K dia HEe
@ cmm 11KB
-3 deploy
-0 ext = java. i javaws. policy
&) fonts : POLICY File
J Rb R K]
{7 1386 e
{3 im
F-C) images |
--{3) management
-3 security
{3 servicetag
-5 4
-3 microsoft frontpage
£ Microsoft Office b o
Kl | 3 4| | B
[Type: POLICY File Date Modified: 1/11/2012 10:34PM Size: 2.20KB  [2.20KB [ 5 My Computer Y

3 Execute the Java Policy Tool file (policytool.exe) by double-clicking on it
from the following folder: Program Files\Java\jrel.7.0_xx\bin (where xx is
either 00 or 51. If you have folders for both jrel.6.0_30 and jrel.7.0_51,
use the jrel.7.0_51 folder.).

File Edit View Favorites Tools Help |";'
Q- ) - (T ] Pseear [ 7o [ [ 37 X 9[-

Address [ C:\Program Fies\Javaljre 1.6.0_30\bin B
Folders x ‘I
195 | @ OIS

{3 Documents and Settings
{23 Outlock jpishare.dll jgs.exe jgsnotify.exe  jsound.dl jsoundds.dl  keytool.exe kinit.exe

[=1{C5) Pragram Files

[i' g QSZE: Media Player ﬁ E] ﬁ _é] ﬁ

[

B+ Analog Devices Klist.exe ktab.exe  manageme... mib_image.dl msvar7ldl msvert.di net.dl
B3 Apple Software Updz

B3 Appshare
fEpe 3 8 8 § 9
B Citrix

B} Common Files nig.dil npdeployJa... npjpi160_30... npoji610.di npt.dli orbdiexe  pack200.exe

{5 ComPlus Applications

E E:Lrpnse PDF Printe . ﬁ _ﬁj EI

[T Enterprise Vault regutils.dil rmi.dil rmidexe  rmiregistry.... servertool.exe splashscre...
-{{) GPLGS

B3 GuardianEdge

B3 Hewlett-Packard _ﬁ ﬁ _ﬁJ 3}]

[ Internet Explarer

sev.dl sgvagent.exe sunmscapi.dl tnamesery.... unicows.dl unpack200.... unpack.dl
I';'I E Java -
L | : . : : El
|De5cnpﬁon: Java(TM) Platform SE binary Company: Sun Microsystems, Inc, File Version: &.0,300, 12 Date Cr |33.2KB | :J My Computer 4

Tip: Depending on your Windows folder options configuration, the may
appear with just ‘policytool’ as the file name.
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4 If an error dialog appears that starts with “Could not find policy file ...”, click
OK.

£ Ppolicy Tool
File Edit

Policy File: |

Keystare ‘

Add Policy Entry | EditPolicyEntry | Remove Policy Entry

5 To open the “java.policy” file, click File > Open. Remember the file is
located in C:\Program Files\Java\jrel.7.0_xx\lib\security (where xx is
either 00 or 51. If you have folders for both jrel.6.0_30 and jrel.7.0_51,
use the jrel.7.0_51 folder.).

=T

File KeyStare

Policy File: |C:lPr0gram Filestavaljdk1.6.0_30yrellibsecuritijava. policy

Add Palicy Entry Edit Policy Entry Remave Policy Entry

(CodeBase "filedCiDacuments%20and%205ettingsi21 634 3iMy% 20Documentsijdk! B.0_
CodeBase "fileCAINDOVWSISuni)avallibiextr

(| | i
6 In the Policy Tool window, click Add Policy Entry.
Policy Entry E.‘
CodeBase: |
SignedBy. |
Add Principal Edit Principal Remave Principal
Principals
Add Edit Remave Permission

Done Cancel
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7 1In the Policy Entry window, click Add Permission.

Permissions X

Add New Permisgion

[Target Marme: =
[actions: =
Signed By [
m Cangel

8 From the Permission list, select AWTPermission.

9 From the Target Name list, select accessClipboard.

Palicy Entry ['X\
CodeBase: ‘
Signedey: |
Add Principal Edit Principal Remove Principal
Principals
Add Permissian Edit Permission Remove Permission
java.awl AT " Cliphoard’;

Dane Cancel

“permission java.awt.AWTPermission ‘accessClipboard’ appears in Policy
Entry window.

11 Click Done in the Policy Entry window.
A new “CodeBase<ALL>" entry appears in the Policy Tool window.
r\éI Policy Tool =TSN

File KeyStore

Policy File: |[C:\Program Files\JavayjreTVib\s ecurity\java.policy

TAdd Policy Entry | Edit Policy Entry Remove Policy Entry

CodeBase "file/C./Program%20Files/Javaljre7/lib/ext
CodeBase "file:/C:/Windows/SuniJavallibl/ext™ I
CodeBase <ALL=
CodeBase <ALL=
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12 Save the file. (Click File > Save.)

Folicy successfully written to C\Program Files\Wavalj2re1 . 4.2_05\ibsecuribdjava.palicy

13 Click OK.
14 Select File > Exit.

Disabling system clipboard access

The following steps explain how to reverse the above procedure to disable the
System Clipboard access.

1 Execute the Java Policy Tool file (policytool.exe) by double-clicking on it
from the following folder: Program Files\Java\jrel.7.0_xx\bin (where xx is
either 00 or 51. If you have folders for both jrel.6.0_30 and jrel.7.0_51,
use the jrel.7.0_51 folder.).

[ ~=lojx|

Fle Edit Wew Favortes Tools Help |.;,x

Qs - ) - T | POsereh |z roes |13 3 X 9 | E1-

Address [) Cr\Program Files\Javalire 1.6.0_30\pin s
Folders x =
- 3 3
122 Documents and Settings
{2 Outiook jpishare.dl  jgsexe  josnotfy.exe  mounddl  jsoundds.dl  keytoolexe  linitexe

=2 Program Files

- - a a & 3

[,

B

{3 Analog Devices Klist.exe kzb.exe  marageme.. mib_mage.dl  msver7idl  msvertdl net.dl
-3 Apple Software Updz

-3 Appshare
S 18 3 8 3 9
E-{C3) Citrix

{2 Common Flles nio.dl  npdeployJa... mpipi160_30... npojsi0.dl  nptdl orbd.exe  packaDl.exe

123 ComPlus Applications

Bl . 2

{3 Enterprise vault poicytool.exe TN oo ll rmid.exe  rmiregistry.... servertool.exe splashscre...
B2 6res

B3 GuardianEdge »

F1C3) Hewlett-Packard -5. ",!. J.!. '}.

B0 Intemet Bxplorer wvd  wveiter smscandl Hassevisy iswed JisdooeTs sl

E-5D Java -
i — 3 |
[Description: 3ava(TM) Platform SE binary Company: Sun Microsystems, Inc. Fie Version: 6.0.300. 12 Date Cr [33.2KB |3 My Computer v

2 Select File > Open to open the “java.policy” file in the folder Program
Files\Java\jrel.7.0_xx\lib\security (where xx is either 00 or 51. If you have
folders for both jrel1.6.0_30 and jrel.7.0_51, use the jrel.7.0_51 folder.).

The path and filename appear in the Policy File text field and the policy
entries appear in the window.

3 Highlight the appropriate policy entry.
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Disabling system clipboard access

Note: The “appropriate” policy entry is difficult to determine by just
looking at the list. Always view the contents of the policy entry

(steps 3-4) to ensure correctness.

|£| Policy Tool

= [ 5 [ |

File KeyStore

Policy File: |k2 \Program Files\Java\jre 7\ib\security\java.policy

Add Policy Entry Edit Policy Entry Remove Policy Entry

CodeBase filed/C:/Program®%20Files!Javaljre T lliblext™”
CodeBase "file/C:AWindows/SuniJavalliblexd™
CodeBase <ALL=

4 Select Edit Policy Entry button to view the contents of the highlighted

policy entry to confirm you have the right entry.

The Policy Entry window appears, showing the “accessClipboard”

permission as the correct entry.

Note: If the line of text ends with anything other than
“accessClipboard”, you have chosen the wrong policy entry and
must choose a different policy entry (return to step 3).

Palicy Entry ﬁ\

CoteBase: |
Signedy: |

Add Principal Edit Principal Remave Principal

Principals:

Add Permission Edit Permission Remave Permission

permission java.awl ANTPermission "aceessClipboard”;

Done Cancel

5 Click Cancel to exit the Policy Entry window.
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6 When you’ve found the right entry, highlight it and click Remove Policy
Entry.

< Remove Paolicy Entry

Remuove this Paolicy Entry?
Grant CodeBase =ALL=

permISsion java awt AWTPermission "accessClipboard”;

ok

7 To remove the policy entry, click OK.
8 Save the file. (Click File > Save.)
9 Click File > Exit.

Troubleshooting tips

If you do not achieve the correct outcome for either of these procedures,
please work through the steps below in chronological order.

1 You may need to exit from the browser and restart IMA before changes
take effect.

2 Retry the procedure to make sure you have completed every step.

3 Reinstate your backup copy of the “java.policy” file, create a new backup of
it, and retry the procedure.

4 Have your system administrator contact the CenturyLink IT Wholesale
Systems Help Desk (888-796-9102, option 2) to see whether further
assistance is available.

Further assistance

For general information about the java policy file, go to
http://java.sun.com/docs/books/tutorial/security/tourl/step2.html

If you're a system administrator and need additional help, call the CenturyLink
IT Wholesale Systems Help Desk (888-796-9102, option 2).

October 20, 2014 37
http://www.centurylink.com/wholesale/ima/gui/index.html


http://java.sun.com/docs/books/tutorial/security/tour1/step2.html

s :
-~ CenturyLink~

As needed

These procedures don’t fall naturally into the normal sequence of operational
events. The tasks that you will use occasionally are

e modifying your personal profile

e changing your password

Modifying your personal profile

1 In the Interconnect Functions window click User Administration.

@ y v 8] bellhedlRas G
file Edt View Favortes Took Help
dr ar ftome - dmhPne v [rPage - O Tooks - @) Help -

Personal Profile

Name: IMA Documentation
Telephone Number: 111-222-3333
E-Mail Address: imadocs@qwestcom
Fax: 123-456-7890
Street Address: 930 15th Street
Floor: |5
Room/Mail Stop:
City: Denver
State: |CO v
Zip/Postal Code: 80202

Update Database

Return to Main Menu

W Local intranet #100% -

2 Click in each field and type the appropriate information. All fields are
required except

e E-mail Address or Fax (At least one of these must be filled in.)
e Floor

e Room/Mail Stop
3 C(Click Update Database.

IMA displays a message that the database has been updated.
4 Click Return to Main Menu.
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Changing your password
Changing your password

For security reasons, you should change your password often.

1 In the Interconnect Functions window, click Set Password.

{2 Set Password - Windows Internet Explorer

@ - & | 42| x £l
fle Edt View Favortes Took Help

s afr  fGiHome - @ Pnt <~ b Page - ) Taok - (@) Help ~

Set Password

Enter New Password.

Old Password:
New Password:

Re-Type New Password:

Return to Main Menu

% Local intranet H100% -

2 Do the following:

In this field ... Type ...

Old Password Your current password

New Password Your new password (6-8 characters, at least one of which is

a number or special character)

Re-Type New Password

3 Click Set Password.
IMA changes your password.
4 Click Return to Main Menu.
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